
Change the World with YOUR Images!
I want to empower YOUR photography! I want you to be 

able to communicate visually through your photography with 
others about the wonders we are so fortunate to enjoy, even 
more blessed to go out and 
photograph. You can literally 
change the world with your 
images! You’ve already started 
the process and probably 
didn’t know it. Just by learning 
techniques in camera and in 
the digital darkroom that can 
fi nish your image is a giant 
step forward. How do you take 
it forward even further? The 
print!

When you get back 
home from a shoot, how will 
you share your photographic 
experience with your family 
and friends? Yeah, you could 
fi re up the notebook and 
carry it around from person 
to person, but that’s not really 
practical. If you have a digital 
projector, you could have a 
slideshow which would be 
great. The best way though 
would be to print a portfolio 
of your work. Prints, besides 
being a ton of fun to make, are 
a very personal and eff ective 
way to present your visual 
communications to others. 
I want to make sure you can 
go back home and create the 
perfect prints so what follows 
are thoughts and recipes for 
doing just that.

Some of what follows is 
carved in stone technical stuff . 
Other stuff  are insights of mine 
from my own printing that I want to pass along. Just like every 
facet of photography, printing is a very personal venture that 
has enough variables to make the fi nal print very much yours. 
Selection in printer, paper and ink are just a few of the variables 
that can and do change the fi nal output and how you visually 
communicate. My point, experiment! For example, you can get 
sample packs of paper from manufacturers; do it, print tests on 
them and play! Make the print just as much yours as the image 
itself.

What follows then is kinda just scratches the surface of 
how I go about printing. What is here is the Printing Worksheet 

that went with my 3hr presentation at our DLWS even on 
printing. So this is kinda of the abridged addition of that 
presentation, class notes you could call it. I have not gone 
through and fi lled in some of the blanks that are here, the 

biggest is the importance of 
paper which I cannot stress 
enough. Also is the demistifi ng 
some of the horrible myths 
in printing. I have also not 
taken the time to bring this 
up to date for CS5 which does 
have a couple diff erent print 
dialog boxes. Hopefully with 
time, I will be able to fi ll in 
all the blanks and bring this 
completely up to date. The 
most up to date information 
will be on the Moose’s Print 
Lab website. If there is a 
confl ict of information (my 
apolgies in advance), defer 
to that page as being correct. 
For right now though, I hope 
it answers some of your 
questions about printing.

Let’s get to printing.

How do we share our 
images?

There are three ways we 
can share our images, on a 
computer monitor, the printed 
page or prints. Let’s take a 
moment and look at these 
options.

There are two real 
obvious problems with sharing 
images by showing them 
on a computer monitor. The 
most obvious is physical. Your 
desktop computer monitor is 
rather tied down, literally to a 

power & video cable. Yeah, you could have everyone sit around 
your desk, but that doesn’t sound like all that much fun. There 
is your notebook monitor, which isn’t physically tied down, but 
you can only have one maybe two folks looking at your images 
at a time. Why? It’s an LCD, which means that if you’re not 
directly in front of the monitor but off  at an angle, you simply 
won’t see correctly. The other reason is it’s not a perfect source. 
Just adjusting the angle of the monitor when we sit in front of 
it changes what we see.

Now there is the iPad, an amazing tool for sharing our 
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photography! Nothing makes our images look as good as an 
iPad and on a one on one encounter, it’s a great way of sharing 
images. But having extra iPads to give folks so they can keep an 
images isn’t pratical. 

The printed page, getting published, this is a fantastic 
way of sharing your images! I cannot encourage you enough 
to work towards getting your images, your visual message out 
to the public via the printed page! There is no greater high, 
no greater way of reaching a whole lot of folks than with your 
images appearing on the page of a book or magazine. While 
this is ideal, it’s not in everyone’s future. This leaves the most 
practical, romantic and fun way of getting your images shared 
with others by prints that YOU print.

So do you own a printer? That’s great if you do and if you 
don’t, why not? Printing has truly become as easy as just a click. 
Will your fi rst, second or third print come out perfectly? What 
about your 100th? Nope. Why not, because the more you print, 
the more you will want to perfect. You’ll fi nd more to perfect 
technically and more importantly, you’ll fi nd more to correct 
so YOUR message is more succinctly communicated. That’s the 
whole goal behind printing, visual communication. Yes, there 
will be some frustration in the process, but there will be a heck 
of a lot more rewards!

The whole printing process starts when you click that 
shutter. It continues in the fi nishing of your image. And it 
comes to a fruitful conclusion when you output that image to a 
printer. You’ve produced beautiful images. I want to encourage 
and help you all I can to share your vision so hopefully you 
can incorporate at least two of these methods of sharing your 
images into your photographic life.

Thought on Printers
At this point in time, I’ve probably printed on every printer 

you can think of, Epson, HP, Canon and some you’ve probably 
never heard of. While all of them have their pluses and minuses, 
which could be debated to the end of time, it’s the results 
though that truly matter. In all honesty, it’s the results YOU’RE 
looking for in your image and print that truly matter. 

Obviously the 
fi nal print is utmost but 
after that, it’s the speed, 
ease and fun of making 
the print that has to be 
taken into consideration 
when selecting the right 
printer. Some printers 
are too easy, some are 
just downright painful 
and others are truly plug 
and play, which isn’t the 
greatest selling point. 
Hey, if it’s work and not 
fun let’s be honest, we 
won’t do it. So don’t blow 
off  this very important 
part of the formula for 
selecting a printer. You 
gotta have fun!

Next there is size 
and price to consider 
as well. The bigger the 
printer, the bigger the 
price tag. The bigger the 
printer, the bigger the 
prints that it can produce 
and again, the bigger the 

price tag for paper and ink. Just how big is big enough for your 
needs? How many 24x30 prints will you produce, compared 
to say 17x22? When it comes to size don’t forget that once 
printed, you have to fi nd a home, a wall, for that print.

Along with the obvious pluses and minuses of size is 
the real estate required to make a home for the printer. When 
I have hand me down printers to give folks, more than once 
someone has said no thanks because they simply didn’t have a 
place to put the printer. 

How about the simple question, do you want to print 
only color or do you want to get into printing black and white? 
Where do all these considerations get you when selecting a 
printer today?

As of thewinter of 2010, there is one printer I can highly 
recommend for your fi rst printer that provides you with the 
best of all worlds, the Epson 3880. The 3880 can be set up in 
the same space as an Epson 2880 though it is slightly larger. 
The 3880 can print out 17x22” prints very quickly while having 
one of the lowest ink prices per ml of any printer. You can print 
on nearly any paper made and you can make B&W prints just 
as easily as color. The 3880 has both MK & PK ink loaded at the 
same time and when you switch paper from either matte to 
glossy, the printer automatically changes the black ink with 
nearly no loss of ink. 

The 3880 comes with a full set, not a starter set of ink. 
That’s a $450 set of ink which when taken into account, makes 
the 3880 basically the same price as the 2400 when you buy its 
full set of ink that doesn’t come with the printer. With its near 
instant set up (taking off  all the tape does take a moment) and 
easy software installation, the 3880 is by far the best printer for 
your money, time, space and photographs!

Finishing the Photo
I can’t stress enough that great prints start with, and 

often end with, the point of capture. When you have to make 
fi xes in exposure and composition in post processing, print 
quality often suff ers. Is the image degradation measurable? 
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It all depends on just how much fi xing of the original had 
to be done but yeah, it sure can be sometimes. To avoid the 
possibility and to make the biggest, best print possible, get 
the image right from the start in the camera. With that in mind, 
here are the basics in fi nishing the photo to make it ready for 
printing.

Let’s cover the basics. We start with uploading, editing, 
priority tagging and fi ling our images. This is a very important 
part of the process so we can always fi nd and archive our 
images for future use and enjoyment. With that done, we select 
the image we want to work with, copy the Raw fi le to a folder (I 
prefer not working with the original) and open our Raw image 
processor. We process our Raw fi le with ACR and then open it in 
Photoshop. In Photoshop we fi nish our image with techniques 
we’ve learned like through the videos on my site or Kelby 
Training and along with others we’ve learned. We make sure we 
use non-destructive, fl exible techniques and tools like Layers 
to fi nish our image. We do this so if a new tool, technique 
or hardware comes along, we can quickly and easily make 
modifi cations without starting over from scratch. With that all 
accomplished, we save our fi le as a PSD and we’re ready to take 
the last steps to fi nish our image for printing.

Before going any further, you need to make a couple of 
decisions. You need to decide which printer / paper / ink you’re 
going to use in making your print. This is very important and 
not to be taken lightly! While I’ll talk about my own personal 
preferences, you need to make your own decisions and then 
act accordingly. You need to decide if you’re printing color or 
B&W, matte or gloss, fi ne art or rag paper as these choices are a 
BIG part of your printing success.

The three main papers I use are Epson’s UltraSmooth 
Fine Art (Epson 7900) or Hot Press Bright (Epson 4900). By 
far, the USFA is my paper of choice being the paper that all of 
our Moose Gallery prints are printed on for clients. It is simply 
a spectacular paper! This is a matte fi nish paper on a cotton 
rag base. Read more about papers on Moose’s Print Lab page. 
All of these papers have a lifetime longer than mine. Why is 
this important 
to know prior 
to printing your 
image?

I hope you’ve 
learned to work 
with a calibrated 
monitor. No 
matter how anal 
we are about 
profi ling our 
monitor, it doesn’t 
know, nor can it 
accurately display 
what the image 
will look like when 
it comes out of the 
printer without 
some extra 
input from us. To 
get us as close 
as possible to 
matching monitor 
to print (which 
is never perfect), 
we need to tell 
Photoshop what 
paper we’re going 

to print on. We can do that by turning on a real cool feature few 
use, Soft Proofi ng - Soft Proofi ng View > Proof Set Up > Custom.

Soft Proofi ng uses the profi le for our printer/paper so the 
monitor can display it. In the Customize Proof Condition dialog 
box, you’re going to select the paper profi le for the printer/
paper you’re going to print on. To do this, you need to know 
which printer/paper you’re going to use. (Note: this is only truly 
important if you want consistent results. If that doesn’t matter, 
then none of this really matters.)

For discussion sake, we’re going to print on the Epson 
3880 using Epson ink and UltraSmooth Fine Art paper. To 
set up Photoshop for Soft Proofi ng for this combo, we need 
to tell Photoshop some info. Soft Proofi ng View > Proof Set 
Up > Custom, in the dialog box under Proof Conditions for 
the Device to Simulate, we want to select the paper profi le, 
the exact same profi le we’re going to select when we print. 
In this case, the profi le is called Pro38 USFAP. We want 
Rendering Intent set to Relative Colorimetric and Black Point 
Compensation checked. We then click OK. When we do that, 
our image’s appearance will change on the monitor. 

The change might be very subtle or it might be very, very 
dramatic. Most often, you’ll see a change in the blacks and you 
might see a fl attening of the colors. If the change is very subtle, 
you might have to do nothing to print. If the change is dramatic 
or you lose important detail in areas of your image that are 
important to you, then you will have to continue on fi nishing 
the image. Your eye might not see the change when you click 
on OK; your brain might not communicate the nuances that 
have changed. Not a problem, simply toggle the Soft Proof on 
and off  with Ctrl (Cmd) Y. 

You might be asking yourself, “Why not just do all the 
work on the image in Soft Proof mode?” I’ve wondered this 
myself and while I’ve asked, I’ve never gotten a direct answer 
to this question from any of the “printing gurus” . But I have an 
answer that I’ve found for myself. Let’s say you have an Epson 
3880 and an Epson 9800 printer in your offi  ce. Even though 
they use the same inks and you are printing on the same 
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paper, they have diff erent profi les for those papers. If you do all 
your work thinking you’re going to print on the 3880 because 
you’re never going to print bigger than 17X22” and then you 
want to print on the 9800 because you need a bigger print, 
you basically have to start all over working the image. That’s 
because you did all your work based on a specifi c printer and 
its paper profi le. By working your image and then, as one of 
the last steps, Soft Proof, you have a fi le that can be printed on 
any printer with just an extra step rather than reinventing the 
wheel every time. Does that make sense?

With Soft Proof on, make any changes you feel are 
necessary. Quite often, a simple adjustment with a Levels or 
Curves Layer or Saturation is all you need. If this is the case 
and you’re happy with the fi nished image, I highly recommend 
if you’re going to make a number of prints over time of that 
fi le/printer, you do a Save As and add the name of the printer/
paper to the fi le name. It saves a heck of a lot of time the next 
time you want to print the image. With this all accomplished 
and the image looking great with Soft Proof on, fl atten the fi le.

It’s now time to size and sharpen the fi le. With a fl attened 
fi le, we’re going to size it.  We want to size our image prior to 
sharpening. I prefer sizing using Photoshop’s Image>Image 
Size Ctrl (Cmd)-Alt(Opt)-I, typing in the appropriate longest 
measurement (I let PS take care of the other measurement), 
360dpi and selecting Bicubic Smoother. That’s all I do to size 
the image for printing.

The Moose Print Lab Sharpening goes into sharpening 
in greater depth, but here it is in a nutshell. I DO NOT globally 
sharpen. As you’ve seen, I might sharpen certain portions of 
the photo before even getting to this point. It’s now time to 
do the fi nal sharpening before printing. It will be a selective 
sharpening, to sharpen those elements of the photograph 
that I want to make sure the mind is sucked into because of its 
sharpness. 

With a fl attened fi le, I make a copy of the image by simply 
Ctrl (Cmd) J. You’ll see a new layer was just created above the 
Background Layer. With that layer highlighted, I click on Filter 
> Nik Sharpener Pro 2.0 > Epson Inkjet which brings up the 
sharpening dialog box. In the fi rst box, we set the basics which 
are Paper Type and Printer Resolution (the rest of the options 

are fi lled in for us). Paper Type for 
me will either be Matte (USFA or 
VFA) or Luster (MSR or PL) and 
Printer Resolution is 2880x1440. 
Then we click on Advanced. Here, 
we can sharpen by COLOR! This 
gives us even more control over 
selective focus and sharpening. 
You simply click the eyedropper on 
the color you want sharpened and 
bam, you’ve got it.

Once you click OK, the 
layer copy you just created will 
be sharpened globally based on 
your selections in Nik Sharpener 
Pro. We’re now going to create a 
layer mask and fi ll it at the same 
time. Holding down the Alt (Opt) 
key, click on Add Layer Mask 
which creates a fi lled mask (no 
matter the foreground color) 
on the sharpened layer we just 
created. With a soft edge brush, 
50% opacity, paint in those 
elements in the photograph you 
want sharpened. Once you have 

everything sharp that YOU want sharpened, I normally fl atten 
the fi le again. This just makes the fi le size smaller and the 
computer work a little faster.

It’s at this point you might want to add some of your own 
personal character to the print in the form of drop shadow, a 
type of frame (like Laurie demoed) image title and the like.  We 
haven’t talked about adding a drop shadow so let’s add one 
now. There are lots of ways of accomplishing the same thing 
when it comes to adding drop shadows to an image. This is my 
preferred method because it’s fast and accurate. We start with a 
fl attened fi le. Then, holding down the Alt (Opt) key, double click 
on the word Background in the layer. This changes the name 
of the layer to Layer 0. Next we’re going to increase the canvas 
size using a free Automate pluggin (Windows only) called Pro 
Canvas http://photoshopplugins.thegoan.com/procanvas.
html). You can do the same thing (with a little more thinking) 
with Image > Canvas Size. With Pro Canvas we can simply add 
the exact amount to increase the canvas without doing any 
math. In this case, for prints that will be 13x19 and larger, I 
add 1 inch on each side of the image and click OK. The reason 
we changed our image layer name from Background to Layer 
is so when we did this step, we ended up with a transparent 
background. It just makes the process a little easier. Like I said, 
this can be accomplished many diff erent ways, this is just the 
one I prefer. One reason I went this route is because I have 
created an action that with one click, takes care of all of these 
steps for me.

Jumping through the Print Dialog Hoops
What’s presented here IS NOT carved in stone. There are 

other ways, other theories and preferences you can use and still 
be successful at printing. Just like everything in photography, 
there are all sorts of thoughts on the process of printing. I’m 
providing here what I use personally and what I’ve found 
works for me. Please fi ll free to copy all, some or none of what 
I present. Look at the prints hanging about the room and if the 
quality you see there works for you, then by all means follow 
these steps because it’s what I do, literally. (Note: Your dialog 
box might look diff erent, these are all Windows/Epson based 
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printing dialogs).
Printing with CS2

We want to print using the Print with Preview function of 
Photoshop Alt(Opt) + Ctl(Cmd)+ P. That brings up the following 
dialog box.

This is where we make our fi rst settings. We want 
Photoshop to handle our color management, not our printer. 
So we want to set Color Handling as noted above. We then 
want to set the Printer Profi le to the printer/paper we’re going 
to print on. Finally, you want to set Rendering Intent to either 
Perceptual or Relative Colorimetric. There are lots of thoughts  
on which is better; personally, I feel that making a test print 
using both and then determining which is best for the image 
you’re printing is the way to go. Rarely do I fi nd Perceptual 
works best for my prints. With those settings made, I click on 
Print. 

Many will do Page Setup before or at this step. Since I can 
do it in conjunction with the next step and I don’t depend on 
the image preview you see in this dialog box, I found it just 
goes faster clicking on Print. 

That brings up this next dialog box telling you what I 
just was talking about. Just click on Proceed and ignore the 
warning. This brings up the following dialog box, the Print 
dialog box. We’ll see this box again in a moment. Right now, 
we want to click on Properties to get to the next dialog box. 
Don’t click on OK right now. It can be confusing and many 
folks click on OK at this step and that causes disaster. So, click 
on Properties to bring up our next dialog box, the Printer 
Properties Box, in this case the Epson Stylus 3880 Properties.

This is the important dialog box where we tell the printer 
what we want it to do and on what.  You’re going to fi rst, 
make sure the Media Type is set to the paper you’re going to 
use, in this example, 
UltraSmooth Fine Art. 
The drop down menu 
for Color gives you 
the option of Color 
or Advance Black and 

White (if you’re using a new Epson printer). We’re printing color 
this time so we want Color present in the selection. Now click 

on Custom.
Custom permits 

us to access the 
Advance button and 
Advance Dialog which 
is a very important 
dialog box. It’s where 
lots of great prints 
get lost in the dialog 
shuffl  e.  On a side 
note, once you’ve 
done this and once 
you’ve saved your 
settings in Advance, 

rather than clicking on Advance again, you can just click on the 
Custom Settings 
drop down menu 
where you’ll fi nd 
the settings you 
had previously 
saved. These 
settings are saved 
only for the Main 
Tab - Advanced 
settings and do 
not, repeat do not 
save the settings 
you make under 
the Paper Tab. 
We’re assuming 
this is your fi rst 
time through the 
print dialog so 
we’re going to 
click on Advance 
and make some 
selections.

First, make sure the Media Type is still set to the paper 
you’re going to print on. Make sure Color is set to Color.  Next 
comes up one of the fi rst “controversial” selections to make, 
Print Quality. You normally have two options, SuperFine 
1440dpi and SuperPhoto 2880dpi. What’s the diff erence?

The diff erence between SuperFine and SuperPhoto in 
most prints smaller than 13x19 is the use of more ink with no 
appreciable image quality gain. Bigger than 13x19 and the 
image quality gain is really minimal. With that said, what should 
you do? Personally, I recommend testing to make up your 
own mind. All of my prints 13x19 and larger, I print at 2880dpi 
because I can see an increase in the small detail and it’s the 
small detail that counts. Many say they can’t see the detail; they 
should stick with 1440dpi and save the ink. And that’s just fi ne!

High Speed is checked here because it is OK to use High 
Speed, especially on prints smaller than 13x19. This is especially 
true with test prints. On larger prints, I personally turn off  High 
Speed just because. There isn’t a huge speed increase and 
again, with it turned on there is a slight degradation in the 
small details. 

The real, real, real important setting to check here is under 
Printer Color Management. You only have one right answer 
here, Off  (No Color Adjustment). Not having this checked is 
the number one reason folks have prints with bad color.  We 
want Photoshop to take care of color management which 
is why this Off  is checked. Another item if selected, ICM, the 
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printer driver will 
try to manage 
the colors at 
the same time 
as Photoshop, 
because of 
other settings 
we’ve checked. 
This is called 
Double Color 
Management 
and it is not a 
good thing!

It’s after 
you’ve done 
all of this you 
can save your 
settings. Click 
Save Settings 

and give your settings a meaningful name that should include 
paper type. When that is done, you don’t have to go into the 
Advance dialog box again. The setting set you just saved can be 
accessed in the Custom Settings drop down menu in the main 
Properties box. 

You’re going to click OK which closes the Advance dialog 
box and takes you back to the Properties box. Here you can 
check to make sure your settings took if you want. In the lower 
left corner, you will fi nd Print Quality, Color and High Speed 
listed.  I recommend from personal experience to check these 
settings at every step. Be it pilot error or computer problem, 
these settings sometimes get messed up. Save yourself some 
paper, check.

You now want to click on the Paper Tab, next tab to the 
right of the Main tab. This is where we set the paper settings 
for the printer. You know if you’ve not done this if in the Main 
Tab, at the top it says a paper size other than what you’re using 
and if the orientation in the printer is other than what you’re 
printing.

Paper Source is an important thing to select with Epson 
printers. For example, when printing 13x19 USFA paper with 
the 3880, you need to select Manual-Rear. Next, you need to 
select the Paper Size. I have to admit, this is not very clear cut. 
For example, 13x19 paper is the Super A3 selection. Printing 
on 24x30 paper, you have to select User Defi ned and input the 
paper size 
manually, 2400 
x 3600 (it’s 
not in inches). 
When selected, 
you’ll see it 
appear on 
the upper left 
corner.  Next, 
select Portrait 
or Landscape 
and then I 
always click on 
Centered. With 
that, click OK.

This 
brings us back 
to our Print 
dialog box 
where we can 
click OK and 

set the printer in motion.

Printing with CS3/4
Printing in CS3 has been streamlined some with there 

being fewer boxes to negotiate to fi re up the printer. Print 
with Preview is now gone, being incorporated in the general 
print command that’s simply called Print and is accessed with 
File>Print Ctrl (Cmd) P. This is what you see when you fi rst call 
up the print feature. This box has a number of settings com-
bined where they were in separate boxes previously.

The fi rst thing to do is select Printer, in this case the Epson 
7800 is selected. As you can see, you need to know this because 
the drop down menu isn’t big enough to see 7800. Next, select 
Printer Profi le and Rendering Intent and Black Point Compensa-
tion. I’ve selected UltraSmooth Fine Art, Relative ccc and Black 
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Point Compensation is checked. You can check 
Center Image now or in a moment. Once it’s 
checked, it stays checked between printing. 
With that, click on Page Setup which takes you 
to another dialog box.

When you click on Page Setup, the Print-
er Properties box appears. Here, you set the 
Media Type, in this example it’s UltraSmooth 
Fine Art, you set Color or Advanced Black and 
White (if working with Epson printers). If you 
have selected a Media Type that does not sup-
port ABW, ABW will be grayed out. You then 
need to check Custom. With that checked, 
if you have already created and saved an 
Advance Setting for a paper, it will appear in 
the drop down menu. You simply select that 
saved setting and move forward.  If this is your 
fi rst visit to the dialog or you’ve not saved past 
settings, the Advanced dialog box appears where you need to 
make some very crucial choices that will make or break your 
print.

You want to make sure the Media Type selected in the 
Properties dialog matches what the Media Type is in the 

Advanced dialog. You need to make your selection 
of Print Quality, SuperFine 1440dpi or SuperPhoto 
2880dpi (refer to CS2 printing for brief discussion of 
the two). It’s your option to use High Speed or not. 
Personally, I don’t use High Speed on prints over 
13x19” in size. Finest Detail is checked more often 
than not. There are paper size limitations when 
Finest Detail cannot be used, like when I print my 
panos over 40”. 

The very important option to be checked is in 
the Printer Color Management box. You must make 
sure Off  (No Color Adjustment) is checked. If your 
print comes out with an overall green cast, more 
than likely this was not checked. If your print comes 
out with an overall magenta cast, more than likely 
you have a clogged ink jet in the printer. (Note: 
many of your print problems, color, banding, weak 
blacks, are issues of the ink jet in the printer that a 
simple cleaning will fi x.)

If this is the fi rst time through, you might want to save 
your settings with a meaningful name that includes the paper 
name. Don’t feel that once you’ve created a setting you have 

to always use it, not alter it or even delete it as you 
learn more and improve on the original setting. 
Testing is the best way of producing the best print 
for your image!

Click OK and move on to the Paper Tab. The 
Paper Tab is where you need to select Paper Source, 
very important for the Epson printers. You also se-
lect Paper Size. As you can see in the example here, I 
have a number of User Defi ned sizes saved. They are 
the ones under the dashed line in the drop down 
menu. You create these by clicking on User Defi ned 
and then entering the measurement in .01 inch so 
a 24x30” piece of paper would be set up as Width of 
2400 and Height of 3600. You then click on Save and 
give the UD a meaningful name that should include 
the paper. Then click OK.

With that, the Print dialog box appears where 
you simply click OK and away goes your printer.
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Finishing Your Print
We have a couple of suggestions for fi nishing your print. 

The fi rst thing is to let your print “dry” for at least an hour after 

it comes out of the printer. Is the ink runny, smeary or have 
problems that you must dry it? NO, not at all. But putting the 
print fl at and just letting it “dry” prevents any possible problems 
that can rarely appear.

I highly recommend spraying your prints with Premier Art 
Print Shield. This is a coating that greatly increases the life of 
your print, preserving its color against UV light. UltraSmooth 
Fine Art coated with PAPS has a life of more than 150 years! All 
the gallery prints I send out have been sprayed with PAPS so 
you can see for yourself that it leaves no visible trace, yet it’s 
there protecting the prints.

Printing is such a blast and these days, easier than ever to 
produce beautiful color and black and white prints. There are 
lots of creative ways to display and share your prints. Head to 
Light Impressions on the web to see all the diff erent ways you 
can store and share your prints. Warning, all the options will 

just get you more excited about printing!
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